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The Office of Textbooks is responsible for coordinating the Adoption, Distribution,
Care and Use of Textbooks.

The Textbook Adoption Process Summary

The schools of Mississippi follow a five (5) year adoption cycle with the right of
the board, in its discretion, to renew or extend the contract from year to year for
a period not exceeding two (2) additional years, (Section 37-43-19 (c).
Mississippi Code of 1972, Annotated). The detailed steps of this process are as
follows:

1. Subject areas are designated each year and placed on the Adoption
Cycle Calendar.

2. The MS Department of Education distributes the curriculum standards.
3. The publishers submit books for bid that meet the curriculum standards.
4. For each subject area, a seven member State Rating Committee reviews

the submitted books.

5. After the review process, the State Board of Education approves the
textbooks for adoption.

6. Copies of the adopted books are sent to schools by request to each
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school district for administrators and teachers to review.

7. The Textbook Caravan, travels throughout Mississippi to provide each
school district an opportunity to hear presentations about the newly
adopted books. or size of the district.

8. After reviewing the books and attending the presentations on State
Caravan, districts vote on which books they want to use in their schools.

9. Districts purchase the selected textbooks through the depository or
directly from the textbook company.

This is a summary. A detailed explanation on the adoption process can be
found on the web in the Textbook Adoption Handbook .

2013-2014 Textbook Adoption
Handwriting K-8
Mathematics 7-12
English/Language Arts K-12
Social Studies: World Geography and Citizenship (6t grade)

PLEASE SAVE THE DATES: The 2013-2014 Textbook Caravan are tentatively
scheduled from

January 30, 2014 - February 17, 2014.

Please check the website for final schedule and registration information.
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Mississippi Accountability Standards-Textbooks

The school district is in compliance with state law and State Board of Education
policies for state adopted textbooks. {MS Code 37-43-1, 37-43-51, 37-9-14(2)(b).
and 37-7-301(ff)}

26.1 The school district provides each student in each school with current
or otherwise appropriate textbooks that are in good condition. {MS
Code 37-43-1, 37-9-14(2)(b), and 37-7-301 (ff)}

26.2 Each school district shall keep an active and surplus inventory for each
school in the district to be completed by June 30 of each year. The
district shall report the inventory in the Textbook Inventory
Management System. {MS Code 37-43-51} (Refer to page A-12in the
Textbook Administration Handbook Rules and Regulations.)

The document can be downloaded from the welb at
http://www.mde.k12.ms.us/accred/accred

Codes of 1972 Annotated

The Mississippi Codes of 1972, Title 37 - Chapter 43 is the guidelines
used for textbooks. A complete document can be down loaded
from the Secretary of State’s website at www.sos.state.ms.us.

37-43-51. Reports by schools receiving textbooks

The management of all public, private, parochial or denominational schools
wherein the board is furnishing to the students thereof free school textbooks and
said free school textbooks are used by the students in said school, shall file
annually with the State Board of Education any and all reports as may be
required by the board.

Any person who shall refuse, neglect or fail to file any report required by the
board shall be denied a new allocation of funds until such reports have been
completed and filed with the board.
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What is TIMS?

TIMS is the web-based reporting system for the MS Department of Education
Office of Textbooks.

TIMS allows schools to report their active and surplus textbook inventory, as well
as transfer surplus books to other schools.

How do you sign up for TIMS?
TIMS1 form is used to designate a Primary and Secondary contact for your
District. It must be signed by your Superintendent.

TIMS2 form is used to request a user account in TIMS. It must be signed by your
District Primary or Secondary Contact.

What is a school district able to do in TIMS?

Update Active
Request Surplus
Request a Transfer
Run Reports
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THE TEXTBOOK INVENTORY MANAGMENT SYSTEM (TIMS)
SCHOOL DISTRICT TIMS CONTACT MAINTENANCE FORM
(FORM TIMS-1 SUBMIT ONE FORM PER SCHOOL DISTRICT)

(Please Print or Type Information)

SCHOOL DISTRICT SCHOOL DISTRICT
NAME: NUMBER:

ADDRESS:

CITY/STATE/ZIP

PHONE: E-MAIL ADDRESS:

SUPERINTENDENT’S

NAME:

SUPERINTENDENT’S

SIGNATURE: DATE:
(This must be an original signature in blue ink)

(Circle One)
PRIMARY TIMS CONTACT PERSON NEW REQUEST CHANGE

NAME:

TITLE:

PHONE: E-MAIL ADDRESS:

SIGNATURE: DATE:
(This must be an original signature in blue ink)

(Circle One)
SECONDARY TIMS CONTACT PERSON NEW REQUEST CHANGE

NAME: TITLE:

PHONE: E-MAIL ADDRESS:

SIGNATURE: DATE:
(This must be an original signature in blue ink)

SEND COMPLETED FORM TO: SECURITY ADMINISTRATOR
MISSISSIPPI DEPARTMENT OF EDUCATION
MANAGEMENT INFORMATION SYSTEMS
FAX: (601) 359-2027 P.O. BOX 771
PHONE: (601) 359-3959 JACKSON, MS 39205

MIS OFFICE USE ONLY:

RECEIVED BY: DATE:

Revised 10/2006
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THE TEXTBOOK INVENTORY MANAGEMENT (TIMS)
USER SECURITY PROFILE
(FORM TIMS-2 SUBMIT ONE FORM FOR EACH TIMS USER)
(PLEASE PRINT OR TYPE INFORMATION)

DISTRICT DISTRICT
NAME: NUMBER:
SCHOOL SCHOOL

NAME: NUMBER:

Type of Request (Check One):
[ ] NEW REQUEST

[ MODIFY PROFILE OF EXISTING USER REQUESTED

[ I DELETE USER ] EFFECTIVE DATE:
NAME:

TITLE:

PHONE: E-MAIL ADDRESS:

BASED ON THE ACCESS ROLE DEFINITIONS, CHECK THE LEVEL (S) OF USE REQUIRED
FOR THIS USER:

[J TEXTBOOK COORDINATOR (District Level Only) [ PRINCIPAL (School Level Only)

SIGNATURE OF AUTHORIZED TIMS District Contact DATE:
(This must be an original signature in blue ink)

SEND COMPLETED FORM TO: SECURITY ADMINISTRATOR
MISSISSIPPI DEPARTMENT OF EDUCATION
MANAGEMENT INFORMATION SYSTEMS

FAX: (601)359-2027 P.O. BOX 771
PHONE: (601) 359-2837 JACKSON, MS 39205
MIS OFFICE USE ONLY:
APPROVED BY: DATE:

Revised 10/2006
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How can a School District access TIMS?

1. Click on the following link
2.

hitp://www.mde.k12.ms.us/curriculum-and-instruction/textbook-

adoption-and-procurement/tims

*

Transparency MS | MS.GOV | Follow MDE | MDE Emai

* MISSISSIPPI
DEPARTMENT OF
Y™

EDUCATION

Ensuring a l)rightﬁ!um for every child

Home About MDE News & Media MS Schools Reports Public Notices Careers

IN THIS SECTION

Curriculum and Instruction Home
* Staff

* Calendar

« Announcements

* Knowledge Base

* iTunes U

* FAQ

CONTENT AREAS

Advanced Learning and Gifted
Programs

Business and Technology

Dyslexia

Early Childhood

English/L anguage Arts

Foreign Language

Library Media

Mathematics

Physical and Heaith Education
Reading Fair

Science

Social Studies

Standards for Professional Learmning
Textbook Adoption and Procurement
Visual and Performing Arts

-
Textbook Adoption and Procurement

TIMS is down for End of Year Processing until July 15

EPPTIMS Log-on

TIMS Security Form: User Profile
TIMS Security Form: School District

OTHER LINKS

C&! SharePoint Site TIMS Contacts
Common Core State Standards Users Guide
CCSS SharePoint Site New FAQs

Mississippi Virtual Public Schoo!
RESA Reqistration
Unpacking the CCSS for ELA

include your name, school district, and email address

Contact Us

TIMS (Textbook Inventory Management System)

Subscribe to List: Send a request to tims_list@mde k12 ms us. Please be sure to

Textbook Resources
TIMS Log-on

TIMS Information
Subscribe to the TIMS List
Schools

Adoption

Caravan

Catalogs

New Titles

SSL Update

Contacts

Coordinators

School Books Supply Company of
Mississippi

 aapSchoolDivision NASTA
Adoption Schedule

2012-2013 MSIS District Book
Request Manual

MDE Online Helodesk

2. Click on TIMS Log-on
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http://www.mde.k12.ms.us/curriculum-and-instruction/textbook-adoption-and-procurement/tims
http://www.mde.k12.ms.us/curriculum-and-instruction/textbook-adoption-and-procurement/tims

Logon X

Usemame
Password

3. Enter Username
4. Enter Password
5. Database: MDED

6. Click on Connect
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Getting Books into the system

Catalog table
All textbooks must be entered into this table prior to adding to inventory. Adoption textbooks
are uploaded into the system by MIS.

Adding Textbooks to the Catalog

Information pertaining to all textbooks referenced by the TIMS system is stored in the Catalog
Table. Textbooks in this table are indexed by their ISBN numbers. In the event that an ISBN
cannot be located within TIMS, the textbook information must be added to the Catalog table.

orts Query Record Security Help

Click Maintain Tables on the TIMS file menu and choose Catalog.
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Textbo-ok Inventory Management System

v BRequests Transfers Inguiry Beports Query Record Security Help

LS - I e T T T . B ===

MAISSISSTPPT DEPARTMENT OF EDITCATION
TEXTBOOE INVENTORY
CATATOG

mEmaz | f(domotuse dashes ) Editionlnd | |
IsEM.0 | (domotuse dashes-)

Book Title
Fublisher

Subject

SFPED Indicator
Copyright
Book Grade
Age

Aodoptive Ind

Cost
Inactive Itd I:I
Inactive Date

Fiscal ¥ear

WHWW

Transaction Date

* Enter a 13-digit ISBN

* Select Pupil Edition or Teacher Edition from the Edition Ind menu.
(Please verify that you are choosing the correct Edition)

* Enter the Book Title and Publisher information.

* Choose an appropriate subject category and click OK.

* Enter the Copyright year.

* Enter the Book Grade

* Select the appropriate grade and click OK.

* Once all the necessary information has been entered

* Save the information by choosing Save from the File Menu. “Transaction added
successfully” - Click OK

B
If you have more books to update, press the enter query button ( | [ | ) to clear form and
repeat steps above.
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Inventory
(All books in a school’s possession should be added to this system)

Inventory information for all textbooks is stored in the Inventory tables.
These tables are divided into three types: Active, Surplus, and Disposal.
Information in these tables can be updated from the TIMS Inventory menu.

Update Active

Ee VIDCATIOMNAL

’E;E FRMO1 000

TIMS Uz

M= bl 1 inveen e :
Mlanagemment Snestemn

Click Inventory on the TIMS file menu and choose Update Active.
For Textbook Coordinators, a listing of schools in your district will appear.

Select your school and click OK, the Active Inventory form will appear, with school and district
information already entered.
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Update Active

Textbooks Inventory Management System

int il =]l sfe gL

Fila . ] C
b PEREEE A 4 B [ ed o ]

_.b. DMISSISSTPPI DEPARTMENT OF EDUCATION
w;" TEXTBODE INVENTORY
LIMS ACTIVE
Diistrict Number (0130 Hchool Mumber |020 Hchool Phone (601 4452053 Transaction Date
=chool Matme |I'u'IC LATRIN EI EMENTARY SCHOOL
ISBH-13 OTE0324171891 IZEH-10 0324171897
Book Title |PE'_INCIPLES OF MACROECONORICS Inactive Ind | I
Publisher | THOMEON LEARNING Fiscal Vear | 2006 Book Grade [09-12
T otal PE Oty Taotal TE Oty | Editionn | P Copyright Vear | 2004
NOTE: "Total PE Quantity or Total TE Quantity egual
the total amount of boolis in your irventory™
* Enter ISBN

* Once avalid ISBN has been selected, the gray textbook information fields will populate
automatically.

* Enter the quantity of textbooks in the Pupil Edition or Teacher Edition field. You will
only be allowed to enter information in one of these fields, depending on the ISBN
entered.

* Save the information by choosing Save from the File Menu. “Transaction added
successfully” - Click OK

e
If you have more books to update, press the enter query button ( | [H | ) toclear form
and repeat steps above.

* Exit the form by selecting Exit from the File menu, or by clicking on the Close Current
Form icon.
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Transaction Processing

Request Process
(Include Surplus books)

Note: This menu is for making requests only.
The Requests menu will allow you to request surplus books from other schools.

(Requests for books may be made only once, therefore you should know beforehand how many
copies of a book you will need.)

Always enter the total number of books needed for each ISBN entered

If the system is unable to locate enough copies to fulfill your request, it will reserve as many
copies as possible, and place the remainder in the Outstanding section.
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Request Surplus

%= FRMO1000

ieports Query Record Security Help

Click Requests on the TIMS file menu and choose Request Surplus.
If you are a Textbook Coordinator, select the school that will receive the textbooks and click OK.

School information in the Requester Information section of the Request form will be
automatically populated.
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Request Surplus

’é‘_g FREMO2001 REQLUEST SURPLLIS

File Maintain Tables |nwentory Reguests Transfers Inguiry Eeports Query Record Security Help

(i PEEl A4 € 0 B[ 5 d ]

-i?:- MISSISSTPPI DEPARTMENT OF EDUCATION
T‘-I‘-»]vi"s TEXTBOOK INVENTORY
et REQUEST SURFLUS
Catalog Information
[SEN-13 | 9720130501417 |PH -ALGEERA: TOOLS FOR A CHANGING WORLD, 2001

I3EH-10 | 0130501417 Editinnm Copeight | 2001 Fizeal Year | 2001 Inactive Ind | ¥

HWOTE: This form is for Reqguester mformation
requesting surplus itrventory
only NOT FOR INQUIRING Dist| 0130 SchMa | 020 Sch Mame MC LAURIN ELEMENTARY SCHOOL

e P —
- Zch Phone W 445-2953 PE Ouantity | 3 | 5 | :
Drate of Reguest 07/20/20132 TE Quiantity | o | o | o
Total 5 5

e Enter avalid ISBN

* Click OK. The Catalog Information section will automatically populate based on your
selection.

* Enter the number of textbooks needed into the PE Quantity or TE Quantity fields.
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Request Surplus

Idicinacy Hearch ]

Statewide Sea.t‘c]i]

* Click the District Search button or the Statewide Search button.

If textbooks are available within the selected district, the District Search button will be
highlighted for you to click.

If there are no textbooks available within the selected district, the Statewide Search button will
be highlighted.

If there are no textbooks available anywhere, a message will display indicating that there are no
books available in surplus for this ISBN.

| Forms

‘ There is no PE book available in the Surplus for
9780324171891

* Once surplus inventory has been located and populated in the request form, Save the
information by choosing Save from the File Menu. . A message will display indicating
that the transaction was added/updated successfully.

TIMS TRAINING Page 18



‘ Transaction{s} addediupdated successiully.

* Click OK. Exit the form by selecting Exit from the File menu, or by clicking on the Close
Current Form icon.

TIMS TRAINING Page 19



Request Surplus

ests Transfers |nquiry Reports Query Record Security Help

Overview of Request Surplus form
- Catalog Information
- Requestor Information

- Location of Surplus
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Approve/Inquire Requested

ests Transfers |nguiry Reports Query Record Security Help

ovellnquire Requested

To inquire on inventory that has been requested and to change the status of those requests,
* Click Requests on the main menu

* Select Approve/Inquire Requested.
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Approve/Inquire Requested

& Textbooks Inventory Management System
FHFRMO4004 APFROVEIMNQUIRE REQUESTED

o Rjanzn) S S [ o

u
|

) ) )
(| ) )
) | )
(| | |
[ R
) ) |
(| | ) —
) ) )
(| ) )
) ) )
(L]

&l

I S |
I | .|
| F—| —
I | |
| —| w—
| S |
I | .|
I S |

_

L
L1

Textbook Coordinator Role

Select School Number and the Approve/Inquire Requested form will display. You must
Approve or Deny request.

Principal Role

The requested surplus for the selected school will display.
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Approve/Inquire Requested

Textbooks Inventory Management System

’*{EI FRmMO4004 APPROVE/NNGQUIRE REQUESTED

Eile Maintain Tables |nwentory Regquests Transfers Inguiry Eeports Query BEecord Security Help
LS T e T e T T B L =

MISSISSIPFI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY
APPROVE / INQUIRE REQUESTED

FE TE Sch Total Sch Total Transfer
District School Meeded HNeeded INeeded Requested Approwal Transfer Feazon for Desidal
1700 | O14 [ 105 112 [BAs [
From From Reqg Reg

Status Reason for Dendal ISBN-13 ISEN-10  Dist  Sch  PEQty TE Oty Reg Date
| - - || 9720028242266 | 0022343265 || 0930 || 006 15| 0|02s20/2007 |~
| DEHIED ~ | [Currently In Use -3 0028242866 || 0700 || 014 15| 0 |oesz0sz007
[pENDING  +| ~ | 9780030084635 | 0030084636 || 0200 || 008 2|| 0 [peszs2008
| APPROVED  +|| ~ | 9720020750598 | 0030750505 || 1700 || 022 50| 0 |0901s2004
[ APPROVED ~ | 9780138382608 | 0138383657 || 1700 || 022 30|  0/|0%A3/2005

|

|

|

|

=l |
)| | | |
| J | | |
I | | |
)| | | |
I | | |
Onatetanding | |

Book Title | mehn L Gl e

Publisher | Book Grade | Cost | Fiscal Vear Inactive Ind

* The small scroll bar can be used to scroll through the Approve/inquire Requested
entries, however the cursor must be on a specific ISBN in order to change information or
view catalog information.

* Textbook Coordinators may change the status of a surplus request to Approved,
Pending, Denied, or leave the status blank. Should the status for an ISBN be changed to
Denied, a reason must be selected from the Reason for Denial field.

Save the information by choosing Save from the File Menu.
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Approve Surplus Transfers

Transfers Inquiry Reports Query Record Security Help

* The Textbook Coordinator has the ability to change the status of surplus requested from
another District/School by clicking on the Request menu and selecting Approve Surplus
Transfers.

* Select a From School. The District/School is the place where the inventory will be
moved from, and the To District/School is the destination of the inventory. Once
selected, the Approve Surplus Transfers form will appear.
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Approve Surplus Transfers

%3 FRM04005A APPROVE SURPLUS TRANSFERS

| [ &3 dn | I By B 65

0130 | 020 [MCIAURINELEMENTARYSCHOOL |

[aprROVED |
[apeROvED o |
ApPROVED <[ [oraweausesses [ommisssel][ 160 0[000 [0 (\CTNETODEPOSAL [ GG10B | -
ApRovep [ |[ovaoeoownnss [ompwnmss [ si0[ 0[000 [0 (ACTNETOSURPLUS [ Gsmontr
APPROVED <[ |[ormeoowmes [onmwmes] [ a1 (000 [@0] [\CTNETOSORPLS [ 05907
DEED (7805554041 01533404 | 108 0013 [ 20 (ACTIE TODISPOSAL | 010300
ppemoved ([ |[omersssaoin [orsssiois] [ 39| (000 (0] [ACINETODISPOSAL | 060t
APPROVED [ (om0 w0 [ 55| (000 [0 [\CINETODISPOSAL | oom0auss
ArvRoveD <[ [smmmse0i [Gmh0] [ 58| 0| 000 00 [ACTVETODISPOSAL | oom0uns
ZpPRoveD <[ |[ommmseson Gamsa0ss] [ 59| [ 000)[20] [ACTNETODISPOSAL [ 0610205 | -
K
MOSSSSPRIS9GRADES 7] 9]
MACMILLANAMCGRAW HILLSCHOOLD | (0 con [ 500 ) B3]

* The requested surplus for the selected school will display. Textbook coordinators may

select another school in their district by double clicking on the school field to display a
list of available schools.

Textbook Coordinators may change the status of requested surplus to Approved,
Denied, or they may leave the status blank. Should the status for an ISBN be changed to
Denied, a reason must be selected from the Reason for Denial field.

* Changes to this form can be saved by clicking Save on the File menu.

* To exit without saving changes, click File, the Exit.
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Transfer Process

Request Transfer

7= FRMO1000

ers  Inguiry Reports Query Record Security Help
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Request Transfer

Query Rec security Help

* To transfer inventory from one type to another (such as Active, Surplus, or Disposal),
click Transfers on the main menu and select Request Transfer. Enter the district and
school numbers.

* After the From School is entered the user will be prompted to select a To
District/School. The From District/School is the place where the inventory will be
moved from and the To District/School is the destination of the inventory.

*  When the From Dist/Sch and To Dist/Sch have been populated, the Transfer form will
display.
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Request Transfer

= FRM05001 R TRAMSFER

xquests Transfers Inquiry Reports Query Record Security Help

* Select the type of transfer to perform by clicking one of the five available transfer
options.

* The five types of transfer options are:

¢ Active to Active — must be done within the same district. The To Sch cannot be the
same as the From Sch or the system will prompt the user to select a different To Sch
and the From Sch won’t be in the list of choices.

* Active to Surplus — the From Dist/Sch and the To Dist/Sch must be the same or the
system will change it to what is in the From Dist/Sch.

* Active to Disposal — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

*  Surplus to Active — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

TIMS TRAINING Page 28



* Surplus to Disposal — the From Dist/Sch and the To Dist/Sch must be the same or the
transfer option will be disabled.

**Disposals must be approved by the Office of Textbooks

Request Transfer

78 FRMO5001

ests Transfers Inguiry Reports Query Record Security Help

* Transfer Option — Active to Active
¢ Click on Active to Active,

* Enter an ISBN and tab (The copyright, book title, publisher, and transfer date will
automatically populate).

* Enter the PE Quantity or TE Quantity to be transferred. If there was already a request
for this ISBN the system will display the previous request.
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* Ignore the Approval Code field (it will be populated later, automatically). Save the
transfer by clicking File, then Save. The message “Transaction(s) added/updated

successfully” will display.

* Note: Changes cannot be made to a transfer request once it has been saved. If by
chance invalid data was entered and saved, the Textbook Coordinator should deny the
Transfer Request by clicking Transfers on the main menu and selecting Approve/Inquire

transfers.

Approve/Inquire Transfers
(Textbook Coordinators)

%5 FRMO1000
s Transfers Inquiry Reporis Query Record Security Help

Ty

Approvelinguire Transfers
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* Toinquire on transfer requests and to change the status of those requests, click
Transfers on the main menu and select Approve/Inquire Transfers.

* Select the school to be inquired on and click OK. The system will display the
Approve/Inquire Transfers form for the school that was selected

Approve/Inquire Transfers

Textbooks Inventory Management System
*ELH FREMO4005 APPROVE I INQUIRE TRAMNSFERS
Eile Maintain Tables Inwventory Requests Transfers |ngquiry Beports Query Record Security Help

G PR A4 4 p B

-

MISSISSTPPI DEPARTMENT OF EDUCATION
TEXTBOOKS INVENTORY
AFPPROVE / INQUIRE TRANSFERS

District School

[1700° [ D14 [HERMANDO HIGH SCHOOL Total Qty | 938
IEES TE To To Transfer
Status Reason for Denial IZBH-13 IZBH-10 Oty Oty Dist  Sch Transfer Option Date
| APFROVED  ~|| || EEERERE | O026432781 | 24| 0/[1700 | | 014 ||ACTIVE TO SURFLUS |05/07/2010 || =
| APFROVED ~|| || 9720030565030 | 0020565036 || é6 | 01700 | 014 |ACTIVE TO SURFLUS |05/07/2010
[APFROVED ~|| || 9720030565946 | 000565944 | 54| 0|/ 1700 | | 014 ||ACTIVE TO SURFLUS [05/07/2010
| APFROVED  ~|| || 97=0030565960 | 000565960 | 30| 01700 | 014 |ACTIVE TO SURPLUS |05/07/2010
| APFROVED  ~|| || 9720030573286 | 0030573289 | 0| 3 [1700 | 014 |ACTIVE TO SURFLUS [os/m7/2010)
| APFROVED ~|| | 5720030661464 | D030&S1463 | 7L | 0 [1700 | 014 [ACTIVE TO SURPLUS |Bs/07/2010
| APFROVED  ~|| || 97z0075213472 | 0072213479 | 136 | 0|/ 1700 | | 014 ||ACTIVE TO SURFLUS [
| APFROVED ~|| || 9720075684333 | 0072684331 | 0| 6 1700 | 082 |ACTIVE TO ACTIVE |05/31/2012
| APPROVED ~|| || 5720078738302 | oo7e7aEz0 || 10)| 0|1700 | 052 |ACTIVE TO ACTIVE |02/21/2011
[aPFROVED || || 9720130507303 | D130s0730: || 10| 01700 | 042 |ACTIVE TO ACTIVE |os/21/2011 ||~
TOTAL Q25 13
Book Title [GL -FAMILIES TODAY, 2000 Edition | F | Clopyright Tear [2000
Publisher |GLENCOEMWCGRAW-HILL PUE CO BookCrade | 09-12 | Cost | 3996 Fiscal Year 2001 Inactive Ind | I

* If you change the status to Denied the Reason for Denial field will become enabled in
order to select a reason for denial of the transfer request.

* To exit the form after viewing, click File, and then Exit.
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Approve/Inquire Disposal Transfers

%= FRMO1000

File Maintain Tables [nventory Reguests Transfers Inguiry Reports Query Record Security Help

ATl

Approvellnguire Disposal Transfers

* Toinquire on disposal transfer requests, click Transfers on the main menu and select
Approve/Inquire Disposal Transfers.

* Select the school to be inquired on and click OK. The system will display the
Approve/Inquire Disposal Transfers form for the school that was selected
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Approve/Inquire Disposal Transfers

%8 FRM040058 APPROVEANQUIRE ALL DIS AL TRANSFERS

L

IR | (om0 [ 14[  0[acveToDisposal (06292013
D .‘.1I:0_J | Active ToDisposal |[06292013

[
L Jpestex  fokes (omiwms [ 5[ ofAseTobspess 0205 -
s |

2011]
2012

* The Office of Textbooks will Approve or Deny your request.

* To exit the form after viewing, click File, and then Exit.
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Reporting

Reports available in TIMS

Feports CGuery Record Security Help

| Report Inventory cti'u'e Listing
Status
Surplus Requested

Publisher Listing

State Reports *Bsurplus by Subject

_ History Reports Yisurplus by Grade
ZFARKTNENT UF E| - L
Disposal Listing

ransfer Listing

Active by Grade
Surplus Listing

NTORY MANAGEI

Reports

surplus Requested
Publisher Listing

State Reports L4
History R

eports g

T

Query Eecord 3Security Hel

Transfer
Surplus

DUCATION

:NTORY MANAGEMENT SYST

Reports CQuery Record Security Help

Report Inventory L

Status L
Surplus Requested

Fublisher Listing
State Reports

atistical Info Report
_ History Reports I Catalog Listing
SFARTMENT UT B}, e Statewide Listing
Surplus Statewide Listing
INTORY MANAGE! Disposal Statewide Listing
Surplus Requested Listing

Eepors Query Record Security Help
Repaort Inventory »
Status r
Surplus Requested
Publisher Listing

History Reports

:NTORY MANAGEN

FEequested Histary
Transfer History
Erior Disposal Transfers

TIMS TRAINING

Page 34



ory Requests Transfers Inquiry s Query Record Security Help

0130 NATCHEZ-ADAMS SCHOOL DIST

ME  [MARGARET MARTIN MIDDLE SCHOOL

* The TIMS application has many reports for your convenience.

* The Report Inventory section contains reports for Active and Surplus by Listing, Subject,
and Grade, Disposal Listing, and Transfer Listing.

*  You may run the report with just the District/School that is selected or double click the
box next to the school name that says All Schools to get a listing of all schools within
their district.

*  You may also double click on the school number to select another school.

* The report can be customized by all users by entering a specific book title, publisher, or
ISBN.

* After all entries have been made, click Run_Report.
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* After clicking Run_Report, the report will display.

* To exit the report, click File then Close to return to the Run Report form. To exit the Run
Report form, click File, and then Exit.

MISSISSIPPI DEPARTMENT OF EDUCATION
TEXTBOOK INVENTORY
ACTIVE LISTING
07112013
Dist_Sch ISBN-13 Book Title (M Publizher PE TE Cond Grade Subj Cost
s
Qs 9780021473311 M-LATIN AMERICA AND 190 MACOMILLAN MCGRAW- k2 0 NA 06 SOCALSTUDESGRE an
CANADA. 1990 HILL SCHOOLD
Qs 9780021475728 COMMUNITIES 1900 MOGRAWHILL 3 0 NA 03  SOCIAL STUDESGR 3 3100
Qs 9780021476060 UNITED STATES, 1999 1990 g\ﬁu\l_m SCHOOL 23 0 NA 05 SOCALSTUDESGRS
Qs $780021482658 M -MISSISSIPPL 1999 GRADE 1999 MAOMILLAN MOGRAW- 25 0 NA 04 MSHISTORY GRADE 4 3300
4 HILL SCHOOL D
Qs 9780021488551 M-UNITED STATES, 2000 19 MACMILLAN MCGRAW- 18 0 NA 05  SOCIAL STUDESGR 5 091
GRADE § HILL SCHOOL D
Qs 9780022442285 M -MOGRAW-] 1908 MCGRAW- 55 0 NA 03 SPELLINGGR3 174
SPELLING, GR 3, 1998 HILL SCHOOL D
Qs 9780022442203 M -MCGRAW-] 1998 U MCGRAW- b 0 NA 04 SPELLINGGR4 7%
SPELLING. GR 4, 1998 HILL SCHOOL D
211 9780012442300 M (W-HILL 1908 UMOGRAW- s 0 NA 05 SPELLINGGRS 174
SPELLING. GR 5. 1998 HILL SCHOOL D
Qs 9780012442316 M -MOGRAW-HILL 1998 MACMILLAN MOCGRAW- b 0 NA 06 SPELLINGGRS6 174
SPELLING, GR 6. 1998 HILL SCHOCLD
Qs 9780022743017 OTTO OPPOSITE 1995 0 1 NA 02  READING 00
2] 9780022840680 M -HEALTH & WELINESS, 2008 MCGRAW- 100 0 NA 05 HEALTH 4280
2008.GR § HILL INC
2] 780131816589 PH WORLD STUDIES 2005 PRENTICEHALL 387 0 NA 06  SOCIAL STUDIES
WESTERN HEMISPHERE
2 9780153064135 HBI-RHYTHMAND RHYME, 1997 HARCOURT SCHOOL 5 0 NA 01  READING READINESS-BASAL 1485
STU ANTHOLOGY. LEVKEL PUBLISHERS
Qs 9780153340437 HARCOURT SCIENCE 2002 HARCOURT SCHOOL 0 0 NA 05 SCENCEGRS 418
PUBLISHERS
1233 STE0153340424 HARCOURT SCIENCE GRADE 2002 melgsm 458 0 NA 06 SCIENCEGR6S
6
28 9780382348014 AW-SILVER BURDETTGDNN 2001 SCOTT FORESMAN 7 0 NA 01 MATHEMATICSGR1 it )
MATHEMATICS. GR 1. 2001
Qs 9780382363108 AW-MSSILVERBURDETT 2001 SCOTT FORESMAN 604 0 NA 05 MATHEMATICSGRS 4195
GDNN MATHEMATICSGR §
2001
os 9780382363115 AW-MSSILVERBURDETT 2001 SCOTT FORESMAN 2| 0 NA 06 MATHEMATICSGRG 4195
%411\' MATHEMATICS. GR &
(23 9780558372156 M5 SCIENCE EXPLORER. 201 J k] 0 NA 06 SCENCE 7497
(PRENTICE HALL)
Qs 9780558381509 MS SCIENCE EXPLORER. 011 PRENTICE HALL 0 ) NA 06 SCOENCE
TEACHER EDITION
(223 2780618271283 2004 HOUGHTON MIFFLIN CO. 395 0 NA 05 READING 457
Qs 9780618271290 TRIUMPHS 2004 HOUGHTON MIFFLIN CO. 3% 0 NA 0§ READING 4575
121 9780618423637 HM SOCIAL STUDIES UNITED 2005 HOUGHTON MIFFLIN 316 0 NA 05  SOCIAL STUDES
STATES HISTORY
Qs 9780618611218 HM -HOUGHTON 2006 485 0 NA 05 ENGISH 5148
ENGLISH. 2006, GR 5 COMPANY
Qs 9780618611225 ¥ N 2006 N e 0 NA 0§ ENGISH 5250
ENGLISH. 2006. GR § COMPANY
Qs 970618690480 FIFTH GRADE MATH 2007 N 395 0 NA 05  MATHEMATICSGRS
Qs 9780618690476 SIXTH GRADE MATH 2007 N 80 0 NA 0§  MATHEMATICSGRG
s 978066908820 G5-TGWRIIEONTRACK 200 GREAT SOURCEINC 10 0 NA ALL OTHERENGLISHRELATED 2195
HANDBOOK. GR 3. 2002
Qs 9780669467741 G5 -WRITE SOURCE 2000 199 GREAT SOURCE INC 7 0 NA 09  ALLOTHERENGLISHRELATED 1075
HANDBOOK.GR §- MAT
1900
(123 9780669467758 SOURCE 2000 1990 HOUGHTON MIFFLIN 0 7 NA 06 ENGLISH 00
Qs 2780669471663 G5 -T/G WRITERS EXPRESS 1995 GREAT SOURCEINC 0 1 NA 0405 ALL OTHER ENGLISHRELATED (2]
HANDBOOK GRADE 4-5 2000 MATERIALS
TOTAL 7314 69
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** If your report doesn’t display, please verify that your popup blocker is turned off**

= MDE Home - Windows Internet Explorer
VAW I;% http://www.mde.kl12.ms.us Q‘Ll + X e MDE Home x | |

File Edit View Favorites WGTEN Help

* Delete browsing history... Ctrl+Shift+Del
InPrivate Browsing Ctrl+Shift+P
Tracking Protection...

. ' ActiveX Filtering Custom

Reopen last browsing session

Ensuring a b

Add site to Start menu PARENTS I
View downloads Ctrl+) L W J

Pop-up Blocker » Turn off Pop-up Blocker
SmartScreen Filter » Pop-up Blocker settings

Manage add-ons 1y 4

At MDE, w

S : access to!

Compatibility View settings leadtoa b

leaming. T

parents, st

d discovery » anyone im

Windows Update find what y

F12 developer tools

Send to OneNote
Blog This in Windows Live Writer

Internet options Public Notices Caree

- Mississippi Board of Education
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SECURITY USER LISTING REPORT
(Textbook Coordinators can access this report)

The Security User Listing Report is a listing of all Users in a district, it includes First
and Last name of the User, the user name, and the role of the user.

e To obtain a Security User Listing, click Security and select Security User
Listing Report.

’?cfl FRMO1000

File Maintain Tahles |nventory Regquests Transfers |nguiry Beports Query Record Security Help

il ggsql Bimiiinl 4 4 b B o4 I Change User Password
Marmtar User

fl&intain Fole
Aesign Usersio Rale

Assinn Users o BErm s
i

* Assign Users to Reports
j MISSISSIPPI DEPARTMENT OF ED Aesign Users DistrictEchool Riohis
Assinn Users Applicatinns
TIMS TEXTBOOKS INVENTORY MANAGEM| £ssign Users to Org Codes
T boalke Livvevitos y | EE':'.“‘ir!." Lizer LiE:ﬁrlg F-!E!pl:lr't

N1;3|1,1g¢|11cr1t .'j‘ll,"f.lr:'l'n

FIGURE 1.0

e The Textbook Coordinator must then select a school for which to run a
report. The Run Report form will display. (Figure 1.1)

e Click the box next to the school name that says All Schools to get a listing of
all schools within a district.
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Reguests Transfers Inguiry Eepors by Becord Security Help

sl B imipiinl @ 4 b B s el [
_?*.: MISSISSTPPI DEPARTRENT OF EDUCATION
t‘{f?:s TEXTROOK INVENTORY MANAGEMENT SYSTEM
TIAM
J‘:ll:;._'é:’f.-';f;. SECURITY USER LISTING REPORT
Diistrict (2502 HINDS CO AHS All Districts [
Sehool | 411 SCHOOLS AllschootsCle.
Book Title |
Publisherl
ISEN |
RUN_REPORT

Figure 1.1

e Click Run_Report. After clicking Run_Report, the report will display.
(Figure 1.2).

e |f the report does not display in the foreground, minimize the screens on
the desktop to see if the report is in the background.

e To exit the report, click File then Close to return to the Run Report form.
To exit the Run Report form, click File, and then Exit.
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Title

User
Date

District:

TEXTBOOK INVENTORY MANAGEMENT SYSTEM

Security User Listing By District / School

Security User Listing By District / School
T
April 23,2012

2502

Textbook Inventory Management System

TIMS
: Security User Listing By District / School
Pazs 1 of 2

District 2502

Schoal 001 HINDS CO AHS

Lastuame Firstuame ML User Name Role Name

AKER BRUC BBAKE TEXTBOOK COORDINATOR

TIMS PRIMARY CONTACT
AYLOR INISE DTAYL

TEXTBOOK COORDINATOR

Figure 1.2
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Things to Remember about TIMS

e Textbook inventory can be entered year round! When you receive
textbooks, please enter inventory into TIMS, immediately!

e Use the ISBN that is located inside the book on the copyright page.

o Textbooks that are 12 years or older should not be in the TIMS program! It
is an Accreditation violation.

e Save after every fransaction.

***Please subscribe to the TIMS Listserv to receive updates regarding TIMS.

* Transparency MS | MS.GOV | Follow MDE | MDE Email
- MISSISSIPPI
DEPARTMENT OF !
| |EDUCATION —

Ensuring a hnghlﬁuum for every child

EDUCATORS

About MDE News & Media MS Schools Reports Public Notices Careers Contact Us Select MDE Office -

IN THIS SECTION . i ‘

Curriculum and Instruction Home

- Staff e’

« Calendar ! .
* Announcements
« Knowledge Base
* Tunes U

« FAQ

Home

CONTENT AREAS
Advanced Learning and Gifted
Programs
Business and Technology
Dyslexia
Early Childhood :
e e Y Textbook Adoption and Procurement
Foreign Langquage
Library Media TIMS is down for End of Year Processing until July 15
Mathematics -
Physical and Heaith Education
Reading Fair Adoption
_gc'e"icgt . TIMS (Textbook Inventory Management System) Caravan
0Cia! ugies
ey gy S talogs
Standards for Professional Leaming G D?'
Textbook Adoption and Procurement TIMS Log-on New Titles
Visual and Performing Arts TIMS Security Form: User Profile SSL Update
Y = c istr Contacts
OTHER LINKS TIMS Security Form: School District
C&! SharePoint Site TIMS Contacts Coordinators
Common Core State Standards Users Guide
CCSS SharePoint Site New FAQs « School Books Supply Company of
Mississippi Virtual Public School N Mississippi
RESA Reqistration Mis - ‘
Unpacking the CCSS for ELA Subscribe to List: Send a request to tims_list@mde k12 ms us. Please be sure to * aapSchoolDivision NASTA
include your name, school district, and email address Adoption Schedule
* 2012-2013 MSIS District Book
Reauest Manual

Textbook Resources
TIMS Log-on

Subscribe to the TIMS List

SLNTOU
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Subscribe to the TIMS List

I T

e Enter email address
e First and Last Name (optional)
e C(Click on Subscribe

Contact Information

Technical/Security Questions

MIS Help Desk -601-359-3959

E-mail MISAPPS@MDE.12.MS.US

General TIMS Questions

Textbook Office-601-576-7950

E-mail lkendrick@mde.k12.ms.

Office of Textbooks
500 Greymont Avenue, Suite G
P.O. BOX 771
Jackson, MS 39205-0771
Phone (601) 354-7543
Fax (601) 354-7590
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